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 Introduction  

    A complete rewrite of the popular but dated  TOAD 
Handbook , this book covers the very popular Toad for 
Oracle database management and development tool. It 
covers all the popular and key features of Toad, includ-
ing many features that are new additions to Toad version 
12.5. Moreover, this book offers numerous Toad tips and 
tricks, with ample expert advice and techniques—without 
focusing on any particular version of the Oracle database. 
Readers should be able to identify and readily adapt these 
“best practices” to their daily use of Toad.   

     Who Should Read This Book  
 This book should benefit all Toad users. It is ideal for 
a wide range of users, from those who are new to both 
Oracle and Toad, to very sophisticated or experienced users 
of Toad. Furthermore, this book attempts to address the 
specialized needs for three key database personas: database 
administrators, database application developers, and data/
business analysts. In truth, Toad has so many features and 
offers so many benefits that no one book can realistically 
hope to fully cover them all. Thus, each chapter focuses on 
a particular functional or task-related area, covering it in 
depth with illustrations, tips, and techniques  from Oracle 
and Toad experts.  

 This book is ideal for the following types of readers:  

    ▶   The power user who wants easy access to data, 
help with SQL, and help with occasional coding 
assignments   

   ▶   The user who wants to increase his or her productiv-
ity while using the Oracle RDBMS   

IN THIS CHAPTER

 ▶ Who Should Read This Book

 ▶ Why This Book Is Unique

 ▶ How This Book Is Organized
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   ▶   The IT professional who is already familiar with Toad but needs help with its 
extended features   

   ▶   The developer who wants to do something specific but cannot remember how   

   ▶   Any Toad user who wants to learn how to take advantage of Toad’s newly intro-
duced features     

  Why This Book Is Unique  
 This book doesn’t make assumptions about readers’ prior Toad or Oracle administrative or 
development background, so it presents the full range of tips and techniques applicable 
to these tools. The main goal of this book is to illustrate the use of Toad and to serve as a 
handy reference for anyone using the Toad database tool. To this end, the book is liberally 
illustrated with working examples of all topics covered.  

 This book is intended to be a complete, single source of information, usage, tips, and tech-
niques for the Toad tool. It focuses on the following topics:  

    ▶   Toad installation and setup   

   ▶   Development of PL/SQL and SQL statements and scripts in an easy-to-use and intui-
tive environment   

   ▶   Tuning SQL and debugging PL/SQL   

   ▶   Modeling any user’s schema   

   ▶   Routine and advanced DBA tasks   

   ▶   Exporting of data into various formats   

   ▶   Additional features such as ER diagrams, trace file analysis, tablespace management, 
object management, and the ability to add your own favorite editors and programs. 
This book includes a chapter on Toad as a SQL tuning tool, something Toad is very 
good at.     

  How This Book Is Organized  
 The chapters are organized as follows:  

    ▶    Chapter   1   , “Getting Started,” discusses the various versions and editions of Toad, 
and how it is packaged and sold. This chapter also details the installation and 
prerequisites for the computing environment that will run Toad. This chapter has a 
nice section on using Toad for the first time. The goal of this chapter is to jumpstart 
your learning process and make you productive with Toad ASAP.   

   ▶    Chapter   2   , “Fast Track,” is a fast track to customizing Toad at startup, navigating 
the menus, learning the key shortcuts, and customizing Toad for your personal 
preferences.   



How This Book Is Organized xiii

   ▶    Chapter   3   , “Working with SQL,” is all about the SQL Editor and working with SQL. 
This chapter shows a number of ways of creating SQL without doing much typing at 
all. This chapter shows how to set up your own personal code shortcuts, and illus-
trates how to use the SQL Recall (SQL history). This chapter concludes with how to 
create SQL via mouse operations using Query Builder.   

   ▶    Chapter   4   , “Schema Browser,” covers saving, formatting, and reporting on data from 
about any data grid. The focus of this chapter is the Schema Browser and how to 
best configure it for your personal preferences, as well as how to work with the data 
in any data grid. This chapter concludes with a nice walkthrough of the FastReport 
feature built into Toad, a nice report writer.   

   ▶    Chapter   5   , “Working with Data,” finishes the discussion on working with data grids, 
showing the data relationships and how to see them, generating SQL from the rela-
tionships, and more.   

   ▶    Chapter   6   , “Working with PL/SQL,” is for the PL/SQL developer. Toad is rich with 
development features such as code templates, code snippets, and more. This chapter 
covers the PL/SQL Debugger and PL/SQL Profiler that are built into Toad.   

   ▶    Chapter   7   , “Miscellaneous Tools,” illustrates the team-building features built into 
Toad.   

   ▶    Chapter   8   , “Getting Started with Toad Automation,” explores using the Automation 
Designer or Toad’s own programming language to automate repetitive tasks.   

   ▶    Chapter   9   , “Database Administration,” is for the DBAs using Toad. This chapter 
covers the database health check, how to monitor sessions and databases, tablespace 
maintenance, reporting, and more. Toad is an excellent Oracle administration tool.   

   ▶    Chapter   10   , “Toad as a SQL Tuning Tool,” covers how to set up and use explain 
plans in Toad, illustrates useful hints, and reviews how to turn SQL Trace on/off via 
a number of mechanisms (for a session or for an individual SQL), and explores both 
the TKProf interface (the old and true character-mode trace analyzer) and Toad’s 
own trace file browser that allows you to quickly find the problem SQL.    

 We hope you enjoy using this book as much as we have enjoyed writing it.  

 Bert Scalzo  

 Dan Hotka     
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   IN THIS CHAPTER   

    ▶   Editor Window   

 ▶ SQL Editor Output Area

   ▶   Object Describe   

   ▶   Toad Insights   

   ▶   Code Snippets   

   ▶   SQL Recall   

   ▶   Auto Replace   

   ▶   Query Builder    

   CHAPTER 3 

 Working with SQL  

 This chapter covers various aspects of the SQL Editor 
window, such as  

    ▶   Various modes to compile and execute code   

   ▶   Using Toad history for past SQL   

   ▶   Enhancing the interface to best fit your needs   

   ▶   Using little-known items within the SQL Editor   

   ▶   Code templates   

   ▶   Building SQL without typing     

     Editor Window  
 Dell Software has a single editor now for all types of code, 
including SQL and PL/SQL. This editor is the main inter-
face to Toad and enables the execution of SQL and SQL 
scripts, viewing data, saving data into various formats, 
and more. The SQL is saved in a history. Toad saves on 
keystrokes in a variety of ways; you can develop working 
SQL with a minimal amount of key entry. Toad also makes 
it easy for you to rerun recent work (using the Rerun menu 
button; see  Figure   3.1   ).  
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 FIGURE 3.1   Toad SQL Editor panel         

 The SQL Editor is the main interface to Toad. Simply type in a SQL statement and click 
the green triangle execute button       . You can also press F9. This sends the SQL state-
ment that the cursor is on (or the highlighted SQL) to the Oracle database. If the query is 
successful, then the data or success of the statement will be returned and displayed.  

 The Editor button        makes opening additional Editor windows possible. This version of 
Toad enables you to open additional tabs in the Editor window. Simply right-click the tab 
just above the selected statement and select SQL or PL/SQL tab type. This opens another 
Editor window using the same database connection. Use the Editor button in the top-left 
row of buttons to open another Editor window, perhaps using a different connect string.  

  NOTE 

 Hover the mouse over any button to see a brief description of what it does.   
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  TIP 

 You typically have three ways to do most any function in Toad:  

    ▶   Menu item   

   ▶   Keystroke   

   ▶   Function key    

 Activating a menu item shows whether there is a button (it will appear) and any keystrokes 
that you can also use to activate the feature.   

 The top toolbar (refer to  Figure   3.1   ), called the standard toolbar, provides access to various 
Toad browsers, features, commit/rollback, and initiating additional connections. Right-
click on any of these top toolbars and you can select the ones you wish to have visible. 
By closing the ones you don’t use, Toad can perhaps have a larger Editor window. The 
window toolbar shows the active Toad windows. There are also toolbars for team coding, 
desktops, connection, jump search, and workspaces. You can change the color border 
per your needs. Dan uses red borders for SYS and SYSTEM accounts, and then a different  
color for each different Oracle database to which he connects. The next toolbar enables 
you to open code from the file system or from the database and also offers access to other 
features. You can right-click on these toolbars to show or hide the ones you don’t work 
with. The bottom toolbar has the Execute, Execute as Script, Clear, and Halt buttons. The 
Execute button        will run all code in the Editor window. You can also just put the cursor 
on a SQL statement (if there are multiple SQL statements in the Editor window) and click 
this button. Toad will  just execute the one SQL statement. Some people highlight the SQL 
they wish to execute. After execution, the Data Grid output tab will be populated. This 
technique works fine as well. The Execute as a script button        runs the contents of the 
Editor window as if it were using a SQL*Plus character-mode interface. There is a separate 
Script Output tab for the result of this type of execution.  

 The Halt button        stops the current SQL execution. It will un-gray as SQL is executing in 
Toad. This feature is also dependent upon Toad Options ➔ Oracle ➔ Transactions Run in 
Threads selected.  

 The Clear button (see  Figure   3.2    at the cursor position) clears the contents of the SQL 
Editor window. One of the authors likes to simply open a new tab (right-click the tab, and 
select New Tab) and put each individual unit of work in its own tab. Use the + next to the 
existing open tab to open others. These tabs are associated with a single connection to 
the Oracle database. This approach makes it easy to rerun prior SQL statements, particu-
larly when testing. This technique is also useful for PL/SQL code such as packages. Putting 
the package specifications in one  tab and the package body in another tab keeps the two 
separate. The package body won’t compile correctly if any issue exists with the specifica-
tions, as shown in  Figure   3.3   . Dan likes to work with package specifications and the body 
in separate tabs for this reason. This is a good technique to follow. Toad automatically 
puts the package spec and body in separate tabs when opening a package either from a file 
or from the database. This feature is controlled by Toad Options ➔ Editor ➔ Open/Save 
Packages/Types settings. You can choose this behavior or turn this feature off.  
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 FIGURE 3.2   Clear button         

 

 FIGURE 3.3   Toad with separate tabs for the package specification and body         

  TIP 

 You can also initiate multiple logins instead of using multiple tabs. Multiple logins can 
make moving data/objects between instances of Oracle a snap. Multiple tabs share the 
same database connection.   

 The toolbars are easy to configure. Right-click one to see the pop-up menu shown in 
 Figure   3.4   .  
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 FIGURE 3.4   Configuring the toolbars         

 Notice the menu enables you to turn on and off the various toolbars. You can also config-
ure the individual toolbars from here. You can delete unused buttons you find cluttering 
the toolbars, move buttons around, and add additional buttons.  Figure   3.5    shows the 
toolbar configuration menu. The Toolbars tab enables you to turn toolbars on or off. The 
Commands tab enables you to add or delete buttons from each particular area of Toad. 
Drag and drop to move the buttons, remove the buttons, or add additional buttons. The 
Options tab enables you to turn on or off the mouse hover tips,  change the size of the 
icons, and adjust how Toad stores your executed commands.  

 

 FIGURE 3.5   Configuring the toolbar buttons         

 Notice in  Figure   3.4    that you can easily reset these options back to the Toad defaults.  

  TIP 

 One of the authors typically closes the Windows menu, and the Team Coding and 
Connections toolbars to give additional space to the editor windows.    
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  SQL Editor Output Area  
 The data grid has a tool palette that enables the user to scroll up or down the returned 
rows, add rows, and delete rows (see  Figure   3.6   ). Notice the light at the cursor along the 
bottom of the SQL Editor screen (see the cursor position in  Figure   3.7   ). If this is red, then 
the data in this data grid cannot be changed and the commit/rollback/add/delete rows 
buttons will be grayed out. If the pseudo column ROWID was selected in the SQL, then 
this light will be green and the commit/rollback/add/delete rows palette will not be grayed 
out and the data  can be changed.  

 

 FIGURE 3.6   Data Tool palette         

 

 FIGURE 3.7   Toad data grid         

  WARNING 

 Toad only retrieves 500 rows at a time. In Toad11+, moving the scroll bar retrieves the 
next 500 rows. In older Toad versions, if you move the data scroll bar on the right-hand 
side, Toad will retrieve all the remaining rows. Be careful!   

 Many output tabs are available in Toad. These tabs usually automatically display when a 
request occurs for the data contained to be displayed, such as when you execute the PL/
SQL profiler. In that case the Profiler tab should automatically appear.  Figure   3.8    shows 
this list.  
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 FIGURE 3.8   Available output tabs         

 You can easily display or hide these tabs. Right-click the tab line to see all the tabs avail-
able. Simply adjust per your needs. You can also right-click the editor panel and select 
Desktop from that pop-up menu to get the same list.  

 The Breakpoints, Call Stack, and Watches tabs are all associated with the PL/SQL Debugger 
(covered in  Chapter   6   , “Working with PL/SQL”). The Data Grid tab is associated with any 
SQL select statement execution. Data grids appear throughout Toad, and the options that 
are available for this data grid are also available for any data grid. The DBMS Output tab 
shows any DBMS_OUTPUT.Put_Line output from a PL/SQL routine. The Explain Plan 
tab (discussed later this chapter and again in  Chapter   10   , “Toad as a SQL Tuning Tool”) 
shows the SQL execution plan; it also has many display options. To populate this  tab, 
click the Explain Plan button       . The Messages tab shows any output from the executed 
SQL, including error messages (its real value). The Navigator tab displays the Navigator 
panel to the left of the Editor window. The Profiler tab is associated with the PL/SQL 
Profiler discussed in  Chapter   6   . The Query Viewer tab shows SQL and PL/SQL that was 
executed in the SQL window and some interesting statistics such as how long it took to 
execute. This information is useful for either rerunning that exact same SQL or when 
doing performance tuning (to easily compare one SQL execution with  another). The 
REF CURSOR Results tab is also associated with PL/SQL execution. The Script Output tab 
shows character-mode output when the Run as Script button is clicked for execution. 
Team Coding illustrates others’ participation in coding of particular PL/SQL code and is 
covered in  Chapter   7   , “Miscellaneous Tools.” The Trace tab enables SQL statistics and/
or SQL Trace files to be generated and displayed for this particular SQL statement. Notice 
that you can enable both Auto Trace and SQL Trace from this tab (see  Figure   3.9   ). The 
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Trace tab is discussed in detail in  Chapter   10   . The remaining items on this  menu deal with 
these tabs themselves—which ones appear when Toad starts up, where they appear—and 
this includes saving the changes for the next time Toad is started, as well as restoring the 
default settings from when Toad was originally installed.  

 

 FIGURE 3.9   Toad Auto Trace         

 Clicking the Explain Plan button on the lower-left SQL Editor toolbar shows the Oracle 
explain plan for the SQL just executed. Right-clicking in this window enables the display 
to be adjusted.  

 The Auto Trace tab provides a variety of SQL runtime statistics. You can enable this 
feature using the check box or right-click in the editor window and select Auto Trace to 
enable, and then re-execute the SQL to populate the Auto Trace panel. Notice that you 
can also run a SQL trace on this particular SQL from the SQL Trace sub-tab. This feature 
needs the ALTER SESSION privilege; SQL trace is covered in detail in  Chapter   10   . Toad will 
run the SQL trace and either bring up the output using the TKProf Wizard or the Trace 
File browser, depending on  which feature of Toad you have purchased.  

  NOTE 

 The Auto Trace, SQL Trace, and Explain Plan tabs are covered in detail in  Chapter   10   .    
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  Object Describe  
 The F4, or Describe Object button, is one of the most versatile features of Toad. Simply 
put the cursor on a function, table, or other object in the editor window and press the F4 
key, and detail about the object appears. The F4 or Describe window is useful for display-
ing object information and table information including data, syntax, and statistics. You 
can also access this screen by entering DESC <object  name > in the SQL Editor.  

  Figure   3.10    shows a Describe Objects panel. You can call one up by pressing F4 with the 
cursor on the EMP table in the editor window. Notice the tabs across the center of the 
screen. Using those tabs you can easily access the other related objects, constraints, statis-
tics, code, privileges, and more.  

 

 FIGURE 3.10   Describe Objects panel         

 You can drag and drop column names on the Columns tab onto the SQL window and 
show other information such as available indexes, constraints, triggers, and so on from 
this interface as well. This section covers the more important tabs individually.  

  TIP 

 You can drag and drop columns displayed in the Columns tab into the SQL window—SQL 
coding without typing!   
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 The location of the Describe Objects panel can be adjusted.  Figure   3.11    shows the buttons 
that control how the panel appears on the screen.  

 

 FIGURE 3.11   EMP Table Describe Objects panel buttons         

  NOTE 

 Toad 11 and newer put a new tab in this Describe Objects panel for each additional object 
being described. Older Toads open a new Describe Objects panel for each.   

 Buttons across the top of this panel (see  Figure   3.12   ) control many items surrounding 
the object. Use the mouse and hover over any button to display a short description of its 
function. These buttons include:  

    ▶   Add objects to this object   

   ▶   Add to project manager (discussed later in this book)   

   ▶   Alter/analyze/audit   

   ▶   Compare   

   ▶   Create another similar   

   ▶   Create a script   

   ▶   Show in various diagrammers   

   ▶   Generate SQL (generates a select/insert/update/delete and puts it on the clipboard)   

   ▶   Count/truncate    

 

 FIGURE 3.12   EMP Table Describe Tab buttons         
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  WARNING 

 Toad is  not  one of those tools in which you should just click the button to see what it 
does. For example, if you have permissions to delete rows, the Truncate button will delete 
 all  the rows! Be careful out there!   

 The Script tab, shown in  Figure   3.13   , creates a script that could be saved and used to 
re-create the object. You can copy this script into a file and use it when creating a test 
environment for your application.  Figure   3.14    shows the options available when you click 
the Options button on this script panel. Notice the adjustments you can make to the 
scripts. You can include the data, include drop statements, exclude schema owners (useful 
when setting up tables/objects for other users), and make other adjustments.  Figure   3.15    
illustrates the other content that you can include in the script output as  well.  

  TIP 

 The author finds the ability to create scripts from this Scripts tab incredibly useful when 
creating a test environment for an application change.   

 

 FIGURE 3.13   EMP Table Describe Object panel showing Script tab         
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 FIGURE 3.14   Script Tab Options panel         

 
 FIGURE 3.15   Script Tab Tables Option tab         
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 The Export DDL button (shown in  Figure   3.16   ) enables easy DDL syntax generation. 
Notice all the options available for optional syntax in the panel in  Figure   3.17   .  

 
 FIGURE 3.16   Export DDL panel         

 
 FIGURE 3.17   Export DDL Options panel         
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  Figure   3.18    shows another data grid but just for the object selected. You can see the same 
navigation and data control buttons as discussed earlier for the SQL Editor Data Grid tab. 
Many features are common to all data grids and these are covered in detail in  Chapter   5   , 
“Working with Data.”  

 

 FIGURE 3.18   Data Grid panel         

  TIP 

 Be careful with large amounts of data on this panel. Use the Esc key to cancel any long-
running data retrieval.   

 Clicking the Generate Statement button (see  Figure   3.19   ) enables the easy creation of an 
Insert, Update, or Select statement from the visible columns of this data grid. Make your 
selection and then  paste  into the SQL Editor.  

 

 FIGURE 3.19   Generate Statement panel          
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  Toad Insights  
 Toad provides easy creation of SQL. The previously mentioned Describe Objects panel 
enables you to drag and drop columns out of any table object into the SQL Editor. You 
can also enter the table name (or table alias) with a single period, the table name, another 
period, and partial leading column spelling, and Toad will pop up a box containing your 
table object columns and column attributes.  Figure   3.20    shows a table with just a single 
period.  

 

 FIGURE 3.20   Toad Insights pop-up panel         

 You can double-click a column in this pop-up window, or multiple select using the mouse 
and either the Shift (list of items) or Ctrl buttons (specific items in the list) and then 
press the Enter or Return key to add the items to your code at the current cursor position. 
Notice in  Figure   3.21   , three columns were selected, and Toad qualified each with the table 
name! If you are utilizing table aliases, Toad remembers these and will qualify your code 
correctly.  

 

 FIGURE 3.21   SQL Editor after using Insights         
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 Notice earlier in  Figure   3.20    that the items appearing in the Insights panel are in alpha-
betical order. One of the authors prefers the order as they appear in the object. Notice the 
Options button on the Insights panel. You can also access this area via the Configure Toad 
Options button on the top toolbar.  

  Figure   3.22    shows the Toad Insights configuration options. Notice that you can define 
the objects that this feature works on along the top. The center part of this screen allows 
you to  

    ▶   Turn off the feature   

   ▶   Cache the results (default)   

   ▶   Display as text   

   ▶   Sort the list (the author prefers to turn this off)   

   ▶   Delay the popup (handy for those of us who type slowly...)    

 

 FIGURE 3.22   Insights Configuration panel         

 You can see some other items (discussed in  Chapter   6   ) such as the Enable parameter assis-
tance (sometimes the author turns this off as it can slow down PL/SQL coding), and some 
other built-in keystroke assistance.   

  Code Snippets  
 Toad contains bits of code called code snippets. These snippets contain most of the SQL 
functions, date formats, hints, and other bits of SQL and PL/SQL code that are of interest 
to the Oracle developer. Toad configuration options make it possible for additional items 
to be added or existing items to be changed.  
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 To see the Code Snippets panel choose View ➔ Code Snippets. The panel then appears 
and auto hides along the right side of Toad (see  Figure   3.23   ). The push pin button can 
make the panel remain visible on your desktop.  

 

 FIGURE 3.23   Code Snippets panel         

 You simply drag and drop the code pieces from this panel to your code.  

  Figure   3.24    shows the various categories for the snippets. There are snippets for date 
formatting, various function templates for almost anything, and even SQL Optimizer hints 
(discussed some in  Chapter   10   ).  

 

 FIGURE 3.24   Code Snippets code categories         
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 These snippets are configurable as well. Click the Configure Toad Options button (or 
access via the menu using View ➔ Toad Options) and visit the Editor ➔ Code Assistant 
panel as shown in  Figure   3.25   . This panel enables you to either clean up the categories 
you will never use, or better yet, add your own custom code snippets that you can easily 
add to your code via drag and drop.  

 

 FIGURE 3.25   Configuring code snippets          

  SQL Recall  
 Toad saves all the work that was done in any of the editor windows.  

 ALT+Up Arrow and Alt+Down Arrow walk through this storage area. Choose View ➔ SQL 
Recall or press F8 (see  Figure   3.26   ) to open the interface shown in  Figure   3.27   .  

 

 FIGURE 3.26   Accessing SQL Recall         
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 FIGURE 3.27   SQL Recall panel         

 Notice that the SQL Recall panel shows up as an autohide panel on the left side of Toad.  

 You simply double-click a SQL statement in this panel and Toad will open a new tab and 
put the SQL in it.  

  TIP 

 One of the authors uses this SQL Recall during SQL tuning. If a prior SQL statement 
worked better, then it is easy to find and revisit.   

 This version of Toad enables the SQL to be moved to the Personal tab or the Named tab. 
Simply click the Edit Selection button in the SQL Recall window, and then select the 
Personal or Named option from the Type drop-down menu.  

 The buttons on the top of this panel (see  Figure   3.28   ) enable you to do the following:  

    ▶   Save selected SQL to a file   

   ▶   Copy selected SQL to the clipboard   

   ▶   Edit the selected SQL (allows for the SQL to be added to the Personal or Named tabs, 
which makes finding SQL easier, perhaps)   
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   ▶   Delete from the SQL Recall   

   ▶   Load into the SQL Editor (Append, New Tab, or Replace into current tab)   

   ▶   Navigation buttons   

   ▶   Export/Import all the SQL (useful when updating Toad or moving to a new 
computer)    

 

 FIGURE 3.28   SQL Recall panel buttons         

 The Configure Toad Option ➔ Editor ➔ Code Assist SQL Recall settings (see  Figure   3.29   ) 
control how many SQL statements are saved (max is virtually unlimited) and which SQL 
will be saved (all, or just valid ones). The Save Only Valid Statements option saves only 
the successful SQL, enabling more SQL to be saved. Typically, programmers are only inter-
ested in the SQL statements that didn’t have syntax errors.  

 

 FIGURE 3.29   SQL Recall options          
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  Auto Replace  
 Auto replace is like a spell checker; in fact, this feature actually does correct some spelling 
errors as well as correct obsolete code. This feature is activated via the space bar. It takes 
the last item entered since the prior space bar and compares it to a list. If the text is found 
in the list, the auto replace item is automatically substituted.  

 This feature is nice for long column names perhaps (although Toad Insights is a better 
mechanism for this), but it is used more for commonly entered items such as sf for 
SELECT * FROM or pl for DBMS_OUTPUT.PUTLINE( );.  

  Chapter   6    discusses a way to use existing code templates and how to add your own.  

 In an editor window, type in “teh” and when you press the space bar, it will be corrected 
quickly to “the.” The space bar activates the check. If an item is in the Auto Replace panel, 
it is substituted.  

 To remove some auto correct items or to add your own (a good place to add any coding 
shortcut!), choose View ➔ Toad Options, visit Editor ➔ Behavior, and click the Auto 
Replace button on the lower-right part of the Behavior panel.  

  NOTE 

 Notice all the items that you can control in an editor window from this Behavior panel.   

  TIP 

 Dan uses this feature to code his own coding shortcuts.   

 This button opens the dialog in  Figure   3.30   . Notice the “teh” in the left side and the “the” 
in the right column.  
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 FIGURE 3.30   Adding an Auto Replace correct item         

 To add your own code assistants, click the Add button and fill in the grid as shown in 
 Figure   3.30   . One of the authors uses DBMS_OUTPUT.Put_Line frequently, so he wants a 
pl shortcut for it.  Figure   3.31    shows the output when pl is entered and the space bar is 
tapped.  

 

 FIGURE 3.31   Auto Replace used for coding shortcuts          

  Query Builder  
 Toad has a nice Query Builder feature. This feature enables SQL code to be built using 
mouse operations. This feature is excellent for power users, analysts, and managers using 
Toad to create reports and access data but who have little knowledge of the SQL language.  
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 The Query Modeler button is on the standard toolbar (the top menu bar, see  Figure   3.32   ). 
You can also access it via Database ➔ Report ➔ Query Builder, and the button also appears 
on the ER Diagrammer panel.  

 

 FIGURE 3.32   Query Builder button         

 The object palette appears on the right (if it doesn’t automatically appear, click View ➔ 
Object Palette). The various items that can be included in a select statement appear on 
the left.  Figure   3.33    shows the canvas with both the EMP table and the DEPT table. These 
were added using either a double-click operation on each in the object palette or a drag 
and drop mouse operation from the object palette to the canvas. Notice how Toad built 
the SQL in the bottom Generated Query tab. As you click on the column names, Query 
Builder will adjust the SQL! The query  can be executed from here, saved, and even moved 
to a tab in the SQL Editor!  

 

 FIGURE 3.33   Query Builder in action         

 To add WHERE, GROUP BY, HAVING, UNION, and the other clauses, simply double-
click the syntax item of interest and use mouse operations to draw in the options you 
desire.  Figure   3.34    shows the Where Conditions clause panel, accessed by double-clicking 
the Where in the left Query Builder panel (titled Query Browser). Buttons on the toolbar 
control and bring up these same wizards. You can also build WHERE clauses by simply 



 CHAPTER 3  Working with SQL66

dragging a column of interest from the canvas object and drop it on the WHERE clause. 
This feature works for the other items in the left panel as well. If the  operation is a valid 
request, a wizard will appear to finish the syntax.  

 

 FIGURE 3.34   Query Builder using the Where item         

 Notice in  Figure   3.35    that some columns were selected in the EMP and DEPT tables in the 
canvas and that the syntax was adjusted automatically. Also notice that the SQL syntax is 
using ANSI joins. Query Builder is an excellent tool for converting from either ANSI SQL 
to standard Oracle SQL or vice versa! Click the Ansi Join Syntax button, shown by the 
cursor in  Figure   3.35   , and you get the SQL in  Figure   3.36   !  

 

 FIGURE 3.35   Query Builder ANSI SQL         
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 FIGURE 3.36   Query Builder Oracle SQL         

  Figure   3.37    shows the Generated Query panel control buttons. The first two buttons 
enable the generated SQL to be copied to either the editor (a new tab) or to the clipboard. 
The SQL Optimize button is a purchased feature of Toad (it enables the SQL to be auto-
matically tuned). The Execute Query button will run the SQL from the Query Builder 
interface and populate the other two tabs present. The Add Table name button enables all 
the columns to be qualified. The next two buttons make it possible for either an * or the 
distinct clause to be added to the  generated SQL.  

 

 FIGURE 3.37   Generated Query Panel control buttons         

 The Update Diagram and Update SQL can be useful buttons. You can make changes to the 
SQL via typing or you can paste a SQL statement into this generated SQL area and click 
the Update Diagram button, and the diagram in the canvas will be updated. Likewise, you 
can make changes to the diagram in the canvas and click the Update SQL button, and the 
changes will be made to your generated SQL. The Ansi button is a toggle; it will rewrite 
your SQL using ANSI join syntax if clicked. The Add Schema Name to Tables and Add 
Table Names  to Column buttons are also toggle buttons. If clicked down, the SQL text will 
be adjusted accordingly. The final two buttons (Run Query in Threads and Allow Modify 
Query Results) pertain to how you would like to execute the SQL and possibly have the 
ability to change results from within the Query Builder environment.  

 You can add your own subqueries and calculations. There are right-click options under 
each object on the canvas, different options when right-clicking the object header on the 
canvas, and others. Calculations are easy to add by either  

    ▶   Right-clicking the select line on the left Query Builder panel and selecting Add New 
Expression Column as shown in  Figure   3.38   .   

   ▶   Adjusting the text in the Generated Query and clicking the Update Diagram button.    
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 Options for each of the other items appear in this left panel as well. Just right-click 
and check out the various options. Right-clicking the columns on the canvas enables 
column aliases to be added. Right-clicking the table name enables an alias to be defined. 
Remember that a button on the Generated Query panel can add the table name or alias to 
all the columns in the SQL (a good idea).  

 There isn’t any SQL that cannot be built using Query Builder.  Figure   3.38    shows a calcu-
lated column, sal * 1.1, being added to the query.  

 

 FIGURE 3.38   Adding calculations using Query Builder           

     Summary  
 This chapter covered various aspects of the main SQL Editor window. It is easy to build 
SQL, using the describe function and code snippets. You can enhance Toad for your own 
coding style using Auto Replace. Toad remembers the SQL that it has worked with. This 
chapter also covered the Query Builder, a useful tool for those new to Oracle but who 
have a need to access data within the Oracle RDBMS.     
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